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LFUN_ACCENT_ACUTE

Action: Adds an acute accent to the next character typed.

Syntax: accent-acute

LFUN_ACCENT_BREVE

Action: Adds a breve accent to the next character typed.

Syntax: accent-breve

LFUN_ACCENT_CARON

Action: Adds a caron to the next character typed.

Syntax: accent-caron

LFUN_ACCENT_CEDILLA

Action: Adds a cedilla to the next character typed.

Syntax: accent-cedilla

LFUN_ACCENT_CIRCLE

Action: Adds a circle accent to the next character typed.

Syntax: accent-circle

LFUN_ACCENT_CIRCUMFLEX

Action: Adds a circum�ex to the next character typed.

Syntax: accent-circum�ex

LFUN_ACCENT_DOT

Action: Adds a dot accent to the next character typed.

Syntax: accent-dot

LFUN_ACCENT_GRAVE

Action: Adds a grave accent to the next character typed.

Syntax: accent-grave

LFUN_ACCENT_HUNGARIAN_UMLAUT

Action: Adds a Hungarian umlaut to the next character typed.

Syntax: accent-grave

LFUN_ACCENT_MACRON

Action: Adds a macron to the next character typed.

Syntax: accent-macron

LFUN_ACCENT_OGONEK

Action: Adds an ogonek accent to the next character typed.

Syntax: accent-ogonek



LFUN_ACCENT_TIE

Action: Adds a tie over the next two character typed.

Notion: The following char will �nish the tie.

Syntax: accent-tie

LFUN_ACCENT_TILDE

Action: Adds a tilde over the next character typed.

Syntax: accent-tilde

LFUN_ACCENT_UMLAUT

Action: Adds an umlaut over the next character typed.

Syntax: accent-umlaut

LFUN_ACCENT_UNDERBAR

Action: Adds a bar under the next character typed.

Syntax: accent-underbar

LFUN_ACCENT_UNDERDOT

Action: Adds a dot under the next character typed.

Syntax: accent-underdot

LFUN_CAPTION_INSERT

Action: Inserts a caption inset.

Syntax: caption-insert

Origin: Lgb, 18 Jul 2000

LFUN_DATE_INSERT

Action: Inserts the current date.

Syntax: date-insert [<ARG>]

Params: <ARG>: Format of date. The default value (%x) can be set in Preferences->Date format.
For possible formats see manual page of strftime function.

Origin: jdblair, 31 Jan 2000

LFUN_FOOTNOTE_INSERT

Action: Inserts a footnote inset.

Syntax: footnote-insert

Origin: Jug, 7 Mar 2000

LFUN_ERT_INSERT

Action: Inserts an ERT inset.

Syntax: ert-insert

Origin: Jug, 18 Feb 2000

LFUN_FLOAT_INSERT

Action: Inserts a �oat inset.

Syntax: �oat-insert <TYPE>

Params: <TYPE>: type of �oat depends on the used textclass. Usually "algorithm", "table", "�g-
ure" parameters can be given.

Origin: Lgb, 27 Jun 2000
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LFUN_FLOAT_WIDE_INSERT

Action: Inserts �oat insets as in LFUN_FLOAT_INSERT but span multiple columns.

Notion: Corresponds to the starred �oats (�gure*, table*, etc.) in LATEX.

Syntax: �oat-wide-insert <TYPE>

Params: <TYPE>: type of �oat depends on the used textclass. Usually "algorithm", "table", "�g-
ure" parameters can be given.

Origin: Lgb, 31 Oct 2001

LFUN_FLOAT_LIST_INSERT

Action: Inserts the list of �oats in the document.

Syntax: �oat-list-insert <TYPE>

Params: <TYPE>: type of �oat depends on the used textclass. Usually "algorithm", "table", "�g-
ure" parameters can be given.

Origin: Lgb, 3 May 2001

LFUN_WRAP_INSERT

Action: Inserts �oats wrapped by the text around.

Syntax: wrap-insert <TYPE>

Params: <TYPE>: table|�gure

Origin: Dekel, 7 Apr 2002

LFUN_ARGUMENT_INSERT

Action: Inserts an argument (short title) inset.

Syntax: argument-insert

Origin: vermeer, 12 Aug 2002

LFUN_NEWPAGE_INSERT

Action: Inserts a new page.

Syntax: newpage-insert <ARG>

Params: <ARG>: <newpage|pagebreak|clearpage|cleardoublepage> default: newpage

Origin: uwestoehr, 24 Nov 2007

LFUN_MARGINALNOTE_INSERT

Action: Inserts a marginal note.

Syntax: marginalnote-insert

Origin: Lgb, 26 Jun 2000

LFUN_UNICODE_INSERT

Action: Inserts a single unicode character.

Syntax: unicode-insert <CHAR>

Params: <CHAR>: The character to insert, given as its code point, in hexadecimal.

Sample: unicode-insert 0x0100

Origin: Lgb, 22 Oct 2006

LFUN_LISTING_INSERT

Action: Inserts a new listings inset.

Syntax: listing-insert

Origin: Herbert, 10 Nov 2001; bpeng, 2 May 2007
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LFUN_PREVIEW_INSERT

Action: Inserts a new preview inset.

Syntax: preview-insert

Origin: vfr, 28 Mar 2010

LFUN_TAB_INSERT

Action: Insert a tab into a listings inset.

Notion: It also works on a selection.

Syntax: tab-insert

Origin: vfr, Sep 30 2008

LFUN_TAB_DELETE

Action: Delete a tab or up to an equivalent amount of spaces from a listings inset.

Notion: It also works on a selection - it removes a tab or spaces from the beginning of each line
spanned by the selection. This is useful if you want to indent/unindent multiple lines in one action.

Syntax: tab-delete

Origin: vfr, Sep 30 2008

LFUN_QUOTE_INSERT

Action: Inserts quotes according to the type and quote-language preference.

Notion: Currently English, Swedish, German, Polish, French, Danish quotes are distinguished.

Syntax: quote-insert [<TYPE>]

Params: <TYPE>: 'single' for single quotes, otherwise double quotes will be used.

LFUN_INFO_INSERT

Action: Displays shortcuts, lyxrc, package and textclass availability and menu information in a non-
editable boxed InsetText.

Notion: Apart from lfun arguments you can use the following method:
1. input the type and argument of this inset, e.g. "menu paste", in the work area.
2. select the text and run info-insert lfun.

Syntax: info-insert <TYPE> <ARG>

Params: <TYPE>: shortcut[s]|lyxrc|lyxinfo|package|textclass|menu|bu�er
<ARG>: argument for a given type. Look into InsetInfo.h for detailed description.
shortcut[s]: name of lfun (e.g math-insert \alpha)
lyxrc: name of rc_entry (e.g. bind_�le)
lyxinfo: "version" - used version of LYX
package: name of latex package (e.g. listings)
textclass: name of textclass (e.g. article)
menu: name of lfun used in menu
icon: icon of lfun used in toolbar
bu�er: "name"|"path"|"class"|"vcs-tree-revision"| "vcs-revision"|"vcs-author"|"vcs-date"|"vcs-time"

Sample: command-sequence info-insert bu�er path; info-insert bu�er name

Origin: bpeng, 7 Oct 2007

LFUN_BRANCH_INSERT

Action: Inserts branch inset.

Syntax: branch-insert <BRANCH-NAME>

Origin: vermeer, 17 Aug 2003
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LFUN_BOX_INSERT

Action: Inserts Box inset.

Syntax: box-insert [<TYPE>]

Params: <TYPE>: Boxed|Frameless|Framed|ovalbox|Ovalbox|Shadowbox|Shaded|Doublebox
Framed is the default one.

Origin: vermeer, 7 Oct 2003

LFUN_FLEX_INSERT

Action: Inserts CharStyle, Custom inset or XML short element.

Notion: Look into the Customization manual for more information about these elements.
To make this command enabled the layout �le for the document class you're using has to load the
character styles. There are a few contained in the Logical Markup module. You can also of course
create some yourself.
For dissolving the element see LFUN_INSET_DISSOLVE.

Syntax: �ex-insert Name

Params: Name: This name must be de�ned either in your layout �le or imported by some module.
The de�nition is InsetLayout Name or InsetLayout <Flex:Name>. The Flex: pre�x is optional.

Sample: �ex-insert Code

LFUN_SELF_INSERT

Action: Inserts the given string (accordingly to the correct keymap).

Notion: Automatically replace the currently selected text. Depends on lyxrc settings "auto_region_delete".

Syntax: self-insert <STRING>

LFUN_SPACE_INSERT

Action: Inserts one of horizontal space insets.

Syntax: space-insert <NAME> [<LEN>]

Params: <NAME>: normal, protected, thin, quad, qquad, enspace, enskip, negthinspace, h�ll, h�ll*,
dot�ll, hrule�ll, hspace, hspace*
<LEN>: length for custom spaces (hspace, hspace* for protected)

Origin: JSpitzm, 20 May 2003, Mar 17 2008

LFUN_HYPERLINK_INSERT

Action: Inserts hyperlinks into the document (clickable in pdf output).

Notion: Hyperlink target can be set via selection + hyperlink-insert function.

Syntax: href-insert [<TARGET>]

Origin: CFO-G, 21 Nov 1997

LFUN_SPECIALCHAR_INSERT

Action: Inserts various characters into the document.

Syntax: specialchar-insert <CHAR>

Params: <CHAR>: hyphenation, ligature-break, slash, nobreakdash, dots, end-of-sentence, menu-
separator.

Origin: JSpitzm, 6 Dec 2007

LFUN_SCRIPT_INSERT

Action: Inserts a subscript or superscript inset.

Syntax: script-insert <TYPE>

Params: <TYPE>: subscript|superscript

Origin: Georg, 23 Nov 2010
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LFUN_APPENDIX

Action: Start (or remove) Appendix on the given cursor position.

Syntax: appendix

Origin: ettrich, 5 May 1998

LFUN_INDEX_INSERT

Action: Inserts Index entry.

Notion: It automatically takes the word on the cursor position.

Syntax: index-insert [<TYPE:Name>]

Params: <TYPE:Name>: name of the index, if multiple indices are de�ned. with an empty argument,
the default index is selected.

Origin: leeming, 3 Aug 2000

LFUN_INDEX_PRINT

Action: Inserts list of Index entries on a new page.

Syntax: index-print [<TYPE:Name>]

Params: <TYPE:Name>: name of the index, if multiple indices are de�ned. with an empty argument,
the default index is selected.

Origin: Lgb, 27 Feb 1997

LFUN_NOMENCL_INSERT

Action: Inserts Nomenclature entry.

Notion: It automatically takes the word on the cursor position if no symbol is given.

Syntax: nomencl-insert [<SYMBOL>]

Origin: Ugras, 4 Nov 2006

LFUN_NOMENCLATURE_PRINT

Action: Inserts list of Nomenclature entries.

Syntax: nomenclature-print

Origin: Ugras, 4 Nov 2006

LFUN_NOTE_INSERT

Action: Inserts Note on the current cursor postion, move selection inside the inset.

Syntax: note-insert [<TYPE>]

Params: <TYPE>: <Note|Greyedout|Comment> default: Note

LFUN_NOTE_NEXT

Action: Moves the cursor to the begining of next Note inset.

Syntax: note-next

LFUN_PHANTOM_INSERT

Action: Inserts phantom on the current cursor postion, move selection inside the inset.

Syntax: phantom-insert [<TYPE>]

Params: <TYPE>: <Phantom|HPhantom|VPhantom> default: Phantom

Origin: uwestoehr, 30 Jan 2009
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LFUN_NEWLINE_INSERT

Action: Inserts a line break or new line.

Syntax: newline-insert [<ARG>]

Params: <ARG>: <newline|linebreak> default: newline

Origin: JSpitzm, 25 Mar 2008

LFUN_ESCAPE

Action: Clears the selection. If no text is selected call LFUN_FINISHED_FORWARD. Inside math
mode jumps out of the math inset.

Syntax: escape

Origin: Lgb, 17 May 2001

LFUN_DOWN

Action: Moves the cursor one line in downward direction.

Syntax: down

LFUN_UP

Action: Moves the cursor one line in upward direction.

Syntax: up

LFUN_DOWN_SELECT

Action: Moves the cursor one line in downward direction adding the current position to the selection.

Syntax: down-select

LFUN_UP_SELECT

Action: Moves the cursor one line in upward direction adding the current position to the selection.

Syntax: up-select

LFUN_SCREEN_DOWN

Action: Moves the cursor one page in downward direction.

Syntax: screen-down

LFUN_SCREEN_UP

Action: Moves the cursor one page in upward direction.

Syntax: screen-up

LFUN_SCREEN_DOWN_SELECT

Action: Moves the cursor one screen in downward direction adding the current position to the selec-
tion.

Syntax: screen-down-select

LFUN_SCREEN_UP_SELECT

Action: Moves the cursor one page in upward direction adding the current position to the selection.

Syntax: screen-up-select
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LFUN_SCROLL

Action: Scroll the bu�er view.

Notion: Only scrolls the screen up or down; does not move the cursor.

Syntax: scroll <TYPE> <QUANTITY>

Params: <TYPE>: line|page
<QUANTITY>: up|down|<number>

Origin: Abdel, Dec 27 2007

LFUN_SCREEN_RECENTER

Action: Recenters the screen on the current cursor position.

Syntax: screen-recenter

LFUN_SCREEN_SHOW_CURSOR

Action: Repositions the screen such that the cursor is visible.

Syntax: screen-show-cursor

Origin: vfr, 25 Mar 2009

LFUN_CHAR_BACKWARD

Action: Moves the cursor one position logically backwards.

Notion: This is not the action which should be bound to the arrow keys, because backwards may be
left or right, depending on the language. The arrow keys should be bound to LFUN_CHAR_LEFT
or LFUN_CHAR_RIGHT actions, which in turn may employ this one.

Syntax: char-backward

LFUN_CHAR_BACKWARD_SELECT

Action: Moves the cursor one position logically backwards, adding traversed position to the selection.

Notion: See also LFUN_CHAR_BACKWARD.

Syntax: char-backward-select

LFUN_CHAR_DELETE_BACKWARD

Action: Deletes one character in the backward direction (usually the "BackSpace" key).

Syntax: char-delete-backward

LFUN_CHAR_DELETE_FORWARD

Action: Deletes one character in the backward direction (usually the "Delete" key).

Syntax: char-delete-forward

LFUN_CHAR_FORWARD

Action: Moves the cursor one position logically forward.

Notion: This is not the action which should be bound to the arrow keys, because forward may be left
or right, depending on the language. The arrow keys should be bound to LFUN_CHAR_LEFT or
LFUN_CHAR_RIGHT actions, which in turn may employ this one.

Syntax: char-forward

LFUN_CHAR_FORWARD_SELECT

Action: Moves the cursor one position logically forward, adding traversed position to the selection.

Notion: See also LFUN_CHAR_FORWARD.

Syntax: char-forward-select
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LFUN_CHAR_LEFT

Action: Moves the cursor one position "to the left".

Notion: This is the action which should be taken when the "left" key is pressed. Generally, it moves
the cursor one position to the left. However, in Bidi text this become slightly more complicated, and
there are di�erent modes of cursor movement. In "visual mode", this moves left, plain and simple.
In "logical mode", movement is logically forward in RTL paragraphs, and logically backwards in
LTR paragraphs.

Syntax: char-left

LFUN_CHAR_LEFT_SELECT

Action: Moves the cursor one position "to the left", adding traversed position to the selection.

Notion: See also LFUN_CHAR_LEFT for exact details of the movement.

Syntax: char-left-select

LFUN_CHAR_RIGHT

Action: Moves the cursor one position "to the right".

Notion: This is the action which should be taken when the "right" key is pressed. Generally, it moves
the cursor one position to the right. However, in Bidi text this become slightly more complicated, and
there are di�erent modes of cursor movement. In "visual mode", this moves right, plain and simple.
In "logical mode", movement is logically forward in LTR paragraphs, and logically backwards in
RTL paragraphs.

Syntax: char-right

LFUN_CHAR_RIGHT_SELECT

Action: Moves the cursor one position "to the right", adding traversed position to the selection.

Notion: See also LFUN_CHAR_RIGHT for exact details of the movement.

Syntax: char-right-select

LFUN_WORD_BACKWARD

Action: Moves the cursor to the logically previous beginning of a word.

Notion: This is not the action which should be bound to the arrow keys, because backwards may be
left or right, depending on the language. The arrow keys should be bound to LFUN_WORD_LEFT
or LFUN_WORD_RIGHT actions, which in turn may employ this one.

Syntax: word-backward

LFUN_WORD_BACKWARD_SELECT

Action: Moves the cursor to the logically previous beginning of a word, adding the logically traversed
text to the selection.

Notion: See also LFUN_WORD_BACKWARD.

Syntax: word-backward-select

LFUN_WORD_DELETE_BACKWARD

Action: Deletes characters to the begining of the word (usually the "C+BackSpace" key).

Syntax: word-delete-backward

LFUN_WORD_DELETE_FORWARD

Action: Deletes characters to the end of the word (usually the "C+Delete" key).

Syntax: word-delete-forward
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LFUN_WORD_FIND_FORWARD

Action: Search for a given string in forward direction.

Notion: Case sensitive, match words. If no argument given, last search repeated.

Syntax: word-�nd-forward [<STRING>]

Origin: Etienne, 16 Feb 1998

LFUN_WORD_FIND_BACKWARD

Action: Search for a given string in backward direction.

Notion: Case sensitive, match words. If no argument given, last search repeated.

Syntax: word-�nd-backward [<STRING>]

Origin: Etienne, 20 Feb 1998

LFUN_WORD_FIND

Action: Search for next occurence of a string.

Syntax: word-�nd [<DATA>]

Params: <DATA>: data encoded from Find dialog (see lyx::�nd2string()). If no parameter is given,
search with last �nd-dialog data is used for search (i.e. �nd-next).

Origin: Andre, Jan 7 2004

LFUN_WORD_REPLACE

Action: Replace a string in the document.

Syntax: word-replace [<DATA>]

Params: <DATA>: data is of the form "<replace>
<search>
<casesensitive> <matchword> <all> <forward>"

Origin: Andre, Jan 7 2004

LFUN_WORD_FINDADV

Action: Search for next occurence of a pattern.

Syntax: word-�ndadv [<DATA>]

Params: <DATA>: data encoded from FindAdv dialog (see lyx::�ndadv2string()). If no parameter
is given, search with last �nd-dialog data is used for search (i.e. �nd-next).

Origin: Tommaso, Nov 15 2007

LFUN_WORD_FORWARD

Action: Moves the cursor to the logically next beginning of a word.

Notion: This is not the action which should be bound to the arrow keys, because forward may be left
or right, depending on the language. The arrow keys should be bound to LFUN_WORD_LEFT
or LFUN_WORD_RIGHT actions, which in turn may employ this one.

Syntax: word-forward

LFUN_WORD_FORWARD_SELECT

Action: Moves the cursor to the logically next beginning of a word, adding the logically traversed text
to the selection.

Notion: See also LFUN_WORD_FORWARD.

Syntax: word-forward-select
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LFUN_WORD_LEFT

Action: Moves the cursor to the next beginning of a word "on the left".

Notion: This is the action which should be taken when the (e.g., ctrl-) "left" key is pressed. Generally,
it moves the cursor to the next beginning of a word on the left. However, in Bidi text this become
slightly more complicated, and there are di�erent modes of cursor movement. In "visual mode", this
moves left, plain and simple. In "logical mode", movement is logically forward in RTL paragraphs,
and logically backwards in LTR paragraphs.

Syntax: word-left

Origin: dov, 28 Oct 2007

LFUN_WORD_LEFT_SELECT

Action: Moves the cursor to the next beginning of a word "on the left", adding *logically* traversed
text to the selection.

Notion: See also LFUN_WORD_LEFT for exact details of the movement.

Syntax: word-left-select

Origin: dov, 28 Oct 2007

LFUN_WORD_RIGHT

Action: Moves the cursor to the next beginning of a word "on the right".

Notion: This is the action which should be taken when the (e.g., ctrl-) "right" key is pressed. Gen-
erally, it moves the cursor to the next beginning of a word on the right. However, in Bidi text this
become slightly more complicated, and there are di�erent modes of cursor movement. In "visual
mode", this moves right, plain and simple. In "logical mode", movement is logically forward in LTR
paragraphs, and logically backwards in RTL paragraphs.

Syntax: word-right

Origin: dov, 28 Oct 2007

LFUN_WORD_RIGHT_SELECT

Action: Moves the cursor to the next beginning of a word "on the right", adding *logically* traversed
text to the selection.

Notion: See also LFUN_WORD_RIGHT for exact details of the movement.

Syntax: word-right-select

Origin: dov, 28 Oct 2007

LFUN_WORD_SELECT

Action: Puts the word where the cursor stands into the selection.

Syntax: word-select

Origin: Andre, 11 Sep 2002

LFUN_WORD_CAPITALIZE

Action: Capitalizes the words in the selection (i.e. the �rst letters) or the letter on the cursor position.

Syntax: word-capitalize

LFUN_WORD_UPCASE

Action: Change the words in the selection or from the cursor position to the end of word to the upper
case.

Syntax: word-upcase
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LFUN_WORD_LOWCASE

Action: Change the words in the selection or from the cursor position to the end of word to the lower
case.

Syntax: word-lowcase

LFUN_SPELLING_ADD

Action: Add the word under the cursor to the respective spell checker dictionary.

Syntax: spelling-add [<STRING>] [<LANG>]

Params: <WORD>: word to add <LANG>: language name (see �le languages)

Origin: JSpitzm, 18 Jan 2010

LFUN_SPELLING_IGNORE

Action: Let the spell checker ignore the word under the cursor in the current session for the given
language.

Syntax: spelling-ignore [<WORD>] [<LANG>]

Params: <WORD>: word to ignore <LANG>: language name (see �le languages)

Origin: JSpitzm, 18 Jan 2010

LFUN_SPELLING_REMOVE

Action: Remove the word under the cursor from the respective spell checker dictionary.

Syntax: spelling-remove [<STRING>] [<LANG>]

Params: <WORD>: word to remove <LANG>: language name (see �le languages)

Origin: SWitt, 28 July 2010

LFUN_THESAURUS_ENTRY

Action: Look up thesaurus entries with respect to the word under the cursor.

Syntax: thesaurus-entry [<STRING>] [lang=<LANG>]

Params: <STRING>: word to look up <LANG>: language (see �le languages)

Origin: Levon, 20 Jul 2001

LFUN_BUFFER_BEGIN

Action: Move the cursor to the beginning of the document.

Syntax: bu�er-begin

LFUN_BUFFER_BEGIN_SELECT

Action: Move the cursor to the beginning of the document adding the traversed text to the selection.

Syntax: bu�er-begin-select

LFUN_BUFFER_END

Action: Move the cursor to the end of the document.

Syntax: bu�er-end

LFUN_BUFFER_END_SELECT

Action: Move the cursor to the end of the document adding the traversed text to the selection.

Syntax: bu�er-end-select
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LFUN_INSET_BEGIN

Action: Move the cursor to the beginning of the current inset if it is not already there, or at the
beginning of the enclosing inset otherwise

Syntax: inset-begin

Origin: lasgouttes, 16 Mar 2009

LFUN_INSET_BEGIN_SELECT

Action: Move the cursor to the beginning of the current inset if it is not already there, or at the
beginning of the enclosing inset otherwise (adding the traversed text to the selection).

Syntax: inset-begin-select

Origin: lasgouttes, 16 Mar 2009

LFUN_INSET_END

Action: Move the cursor to the end of the current inset if it is not already there, or at the end of the
enclosing inset otherwise

Syntax: inset-end

Origin: lasgouttes, 16 Mar 2009

LFUN_INSET_END_SELECT

Action: Move the cursor to the end of the current inset if it is not already there, or at the end of the
enclosing inset otherwise (adding the traversed text to the selection).

Syntax: inset-end-select

Origin: lasgouttes, 16 Mar 2009

LFUN_INSET_SELECT_ALL

Action: Selects all contents of an inset.

Syntax: inset-select-all

Origin: vfr, 22 Aug 2009

LFUN_SECTION_SELECT

Action: Selects the whole section.

Notion: The cursor should be in a section heading before calling this lfun.

Syntax: section-select

Origin: vfr, 05 May 2009

LFUN_LINE_BEGIN

Action: Move the cursor to the begining of the (screen) line.

Syntax: line-begin

LFUN_LINE_BEGIN_SELECT

Action: Move the cursor to the beginning of the (screen) line adding the traversed text to the selection.

Syntax: line-begin-select

LFUN_LINE_END

Action: Move the cursor to the end of the (screen) line.

Syntax: line-end
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LFUN_LINE_END_SELECT

Action: Move the cursor to the end of the (screen) line adding the traversed text to the selection.

Syntax: line-end-select

LFUN_LINE_DELETE

Action: Deletes the letters to the end of the (screen) line or deletes the selection.

Syntax: line-delete-forward

LFUN_COPY

Action: Copies to the clipboard the last edit.

Syntax: copy

LFUN_CUT

Action: Cuts to the clipboard.

Syntax: cut

LFUN_PASTE

Action: Pastes material (text or picture) from the active clipboard.

Syntax: paste [<TYPE>|<NUM>]

Params: <TYPE>: emf|pdf|png|jpeg|linkback|wmf
<NUM>: number of the selection in the internal clipboard stack to be pasted.

LFUN_CLIPBOARD_PASTE

Action: Pastes text from the active clipboard.

Syntax: clipboard-paste [<ARG>]

Params: <ARG>: "paragraph" will cause pasting as one paragraph, i.e. "Join lines".

Origin: Georg, 10 Jul 2006

LFUN_PRIMARY_SELECTION_PASTE

Action: Pastes the currently selected text.

Notion: Primary selection mechanism is linux-only thing.

Syntax: primary-selection-paste [<ARG>]

Params: <ARG>: "paragraph" will cause pasting as one paragraph, i.e. "Join lines".

LFUN_SELECTION_PASTE

Action: Pastes the the internal selection text in permanent selection.

Notion: Created in order to have middle mouse button pasting correct (bound to command-alternatives
selection-paste ; primary-selection-paste paragraph).

Syntax: selection-paste

Origin: lasgouttes, 14 Jan 2009

LFUN_UNDO

Action: Undoes the last edit.

Syntax: undo

LFUN_REDO

Action: Redoes the last thing undone.

Syntax: redo
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LFUN_REPEAT

Action: Repeat the given command.

Syntax: repeat <COUNT> <LFUN-COMMAND>

Origin: Andre, 27 Oct 2003

LFUN_CHARS_TRANSPOSE

Action: Transposes the character at the cursor with the one before it.

Syntax: chars-transpose

Origin: Lgb, 25 Apr 2001

LFUN_DEPTH_DECREMENT

Action: Decrease the nesting depth of the (selected) paragraph(s) inside lists.

Syntax: depth-decrement

LFUN_DEPTH_INCREMENT

Action: Increase the nesting depth of the (selected) paragraph(s) inside lists.

Syntax: depth-increment

LFUN_FONT_BOLD

Action: Toggles the bold font (selection-wise) using mathbf in math.

Syntax: font-bold

LFUN_FONT_BOLDSYMBOL

Action: Toggles the bold font (selection-wise) using boldsymbol in math.

Syntax: font-boldsymbol

LFUN_FONT_TYPEWRITER

Action: Toggles the typewriter family font (selection-wise).

Syntax: font-typewriter

LFUN_FONT_UNDERLINE

Action: Toggles underline in the font (selection-wise).

Syntax: font-underline

LFUN_FONT_UULINE

Action: Toggles double underline in the font (selection-wise).

Syntax: font-underunderline

Origin: sanda, 5 May 2009

LFUN_FONT_UWAVE

Action: Toggles wavy underline in the font (selection-wise).

Syntax: font-underwave

Origin: sanda, 5 May 2009

LFUN_FONT_STRIKEOUT

Action: Toggles strikeout (strike-through) in the font (selection-wise).

Syntax: font-strikeout

Origin: sanda, 3 May 2009
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LFUN_FONT_EMPH

Action: Toggles the emphasis font style (selection-wise).

Syntax: font-emph

LFUN_FONT_NOUN

Action: Toggles Noun text style font (selection-wise).

Syntax: font-noun

LFUN_FONT_ROMAN

Action: Toggles Roman family font (selection-wise).

Syntax: font-roman

LFUN_FONT_SANS

Action: Toggles Sans Serif family font (selection-wise).

Syntax: font-sans

LFUN_FONT_FRAK

Action: Toggles Fraktur family font (math-mode, selection-wise).

Syntax: font-frak

Origin: vermeer, 10 Jan 2002

LFUN_FONT_ITAL

Action: Toggles Italics font shape (math-mode, selection-wise).

Syntax: font-ital

Origin: vermeer, 10 Jan 2002

LFUN_FONT_DEFAULT

Action: Reverts the settings of the font to the default values (selection-wise).

Syntax: font-default

LFUN_FONT_SIZE

Action: Sets font size according to lyx format string.

Syntax: font-size <SIZE>

Params: <SIZE>: tiny|scriptsize|footnotesize|small|normal|large|larger|
largest|huge|giant|increase|decrease|default

LFUN_TEXTSTYLE_APPLY

Action: Toggle user-de�ned (=last-time used) text style.

Notion: This style is set via LFUN_TEXTSTYLE_UPDATE, which is automatically trigerred when
using Text Style dialog.

Syntax: textstyle-apply

Origin: leeming, 12 Mar 2003
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LFUN_TEXTSTYLE_UPDATE

Action: Apply text style and update the settings to be used by LFUN_TEXTSTYLE_APPLY.

Syntax: textstyle-update <FONT_INFO>

Params: <FONT_INFO>: speci�es font atributes, e.g. family, series, shape, size, emph, noun,
underbar, number, color, language, toggleall.
Use lyx -dbg action for exact syntax of text-style dialog parameters.

Origin: leeming, 12 Mar 2003

LFUN_SCREEN_FONT_UPDATE

Action: Update fonts and its metrics.

Notion: Automatically called after zoom, dpi, font names, or norm change.

Syntax: screen-font-update

Origin: ARRae, 13 Aug 2000

LFUN_FONT_STATE

Action: Returns the info about the current font.

Syntax: font-state

LFUN_CITATION_INSERT

Action: Inserts citation from loaded citation database.

Syntax: citation-insert [<KEY>[|<TEXT_BEFORE>]]

Params: <KEY>: Citation (shortcut listed in available citations).
<TEXT_BEFORE>: text which should appear before citation.

Origin: AAS, 97-02-23

LFUN_BIBTEX_DATABASE_ADD

Action: Adds database, which will be used for bibtex citations.

Notion: Databases are added to the �rst BibTEX inset (Inset->List/TOC->BibTEX bibliography)
found from the cursor postion.

Syntax: bibtex-database-add <DATABASE-NAME>

Origin: Ale, 30 May 1997

LFUN_BIBTEX_DATABASE_DEL

Action: Adds database, which will be used for bibtex citations.

Notion: Databases are deleted from the �rst BibTEX inset (Inset->List/TOC->BibTEX bibliography)
found from the cursor postion.

Syntax: bibtex-database-del <DATABASE-NAME>

Origin: Ale, 30 May 1997

LFUN_LAYOUT

Action: Sets the layout (that is, environment) for the current paragraph.

Syntax: layout <LAYOUT>

Params: <LAYOUT>: the layout to use

LFUN_LAYOUT_PARAGRAPH

Action: Launches the paragraph settings dialog.

Syntax: layout-paragraph
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LFUN_LAYOUT_TABULAR

Action: Launches the tabular settings dialog.

Syntax: layout-tabular

Origin: Jug, 31 Jul 2000

LFUN_DROP_LAYOUTS_CHOICE

Action: Displays list of layout choices.

Notion: In the current (as of 2007) Qt4 frontend, this LFUN opens the dropbox allowing for choice
of layout.

Syntax: drop-layouts-choice

LFUN_LAYOUT_MODULES_CLEAR

Action: Clears the module list.

Notion: Clears the list of included modules for the current bu�er.

Syntax: layout-modules-clear

Origin: rgh, 25 August 2007

LFUN_LAYOUT_MODULE_ADD

Action: Adds a module.

Notion: Adds a module to the list of included modules for the current bu�er.

Syntax: layout-module-add <MODULE>

Params: <MODULE>: the module to be added

Origin: rgh, 25 August 2007

LFUN_LAYOUT_RELOAD

Action: Reloads layout information.

Notion: Reloads all layout information for the current bu�er from disk, thus recognizing any changes
that have been made to layout �les on the �y. This is intended to be used only by layout developers
and should not be used when one is trying to do actual work.

Syntax: layout-reload

Origin: rgh, 3 September 2007

LFUN_TEXTCLASS_APPLY

Action: Sets the text class for the current bu�er.

Syntax: textclass-apply <TEXTCLASS>

Params: <TEXTCLASS>: the textclass to set. Note that this must be the �lename, minus the
".layout" extension.

LFUN_TEXTCLASS_LOAD

Action: Loads information for a textclass from disk.

Syntax: textclass-load <TEXTCLASS>

Params: <TEXTCLASS>: the textclass to load. Note that this must be the �lename, minus the
".layout" extension.

LFUN_MARK_OFF

Action: Disable selecting of text-region.

Syntax: mark-o�
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LFUN_MARK_ON

Action: Enable selecting of text-region.

Notion: After enabling you can simply move arrow keys to get selected region.

Syntax: mark-on

LFUN_MARK_TOGGLE

Action: Toggle between LFUN_MARK_ON and LFUN_MARK_OFF .

Syntax: mark-toggle

Origin: Andre, May 5 2006

LFUN_MATH_DELIM

Action: Inserts math delimiters (e.g. parentheses, brackets) enclosing expression.

Syntax: math-delim [<LEFT>] [<RIGHT>]

Params: <LEFT/RIGHT>: Delimiters to be used. Each delimiter can be speci�ed by either a LATEX
name or a valid character. ( is the default letter.

Sample: math-delim { rangle

Origin: Alejandro, 18 Jun 1996

LFUN_MATH_BIGDELIM

Action: Inserts math �xed size delimiters (e.g. parentheses, brackets) enclosing expression.

Syntax: math-bigdelim <LSIZE> <LDELIM> <RSIZE> <RDELIM>

Params: <L/RSIZE>: bigl/r|Bigl/r|biggl/r|Biggl/r
<L/RDELIM>: TEX code for delimiter. See Delimiter dialog for delimiters to be used.

Sample: math-bigdelim "Bigl" "\Downarrow" "Bigr" "\}"

Origin: Enrico & Georg, 7 May 2006

LFUN_MATH_DISPLAY

Action: Creates a new displayed equation in text mode. Toggles inlined/display formula in math
mode.

Syntax: math-display [<ARG>]

Params: <ARG>: this argument will be passed to LFUN_MATH_INSERT when creating new
equation from the text mode.

Origin: Alejandro, 18 Jun 1996

LFUN_MATH_INSERT

Action: Inserts math objects and symbols.

Notion: When <ARG> is a _single_ math inset with more than one cell (such as "x_y^z" or
"\frac{x}{y}"), the content of cell(0) is replaced by the current selection (only works if the selection
is in mathed). As an example, if "abc" is selected in mathed, "math-insert \frac{x}{y}" replaces
"abc" with "\frac{abc}{y}", and "math-insert x_y^z" replaces "abc" with "abc_y^z". If nothing
is selected (or the selection is not in mathed), math-insert works as expected.

Syntax: math-insert <ARG>

Params: <ARG>: Symbol or LATEX code to be inserted.

LFUN_MATH_SUBSCRIPT

Action: Enters subscript expression in math expression.

Syntax: math-subscript

Origin: vermeer, 12 Dec 2001
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LFUN_MATH_SUPERSCRIPT

Action: Enters superscript expression in math expression.

Syntax: math-superscript

Origin: vermeer, 12 Dec 2001

LFUN_MATH_LIMITS

Action: Toggles the position of the limits from above/below to the right side an vice versa in integral
symbol, a limit, a summation, etc.

Notion: Put the cursor before the symbol with the limits and then invoke math-limits.

Syntax: math-limits [<STATE>]

Params: <STATE>: limits|nolimits

LFUN_MATH_MACRO

Action: Inserts a math macro de�nition at the cursor position in the text.

Syntax: math-macro <NAME> [<NARGS>] [def]

Params: <NAME>: The name of the macro, e.g. "mymacro".
<NARGS>: The number of parameters of the macro. Default is 0. "def": Has no e�ect anymore,
just for compatibility with former LYX versions.

Origin: ale, 10 May 1997; sts, 21 Dec 2007

LFUN_MATH_MUTATE

Action: Mutates the type of math inset to the newly selected one.

Syntax: math-mutate <TYPE>

Params: <TYPE>: none|simple|equation|eqnarray|align|alignat|xalignat|xxalignat| multline|gather|�align

Origin: Andre, 23 May 2001

LFUN_MATH_SPACE

Action: Inserts space into math expression.

Notion: Use spacebar after entering this space to change type of space.

Syntax: math-space [<TYPE>] [<LEN>]

Params: <TYPE>: negative spaces: !|negthinspace|negmedspace|negthickspace
positive spaces: ,|thinspace|:|medspace|;|thickspace|enskip|quad|qquad
custom space: hspace
"," used by default.
Note that ! is equivalent to negthinspace, , = thinspace, : = medspace, and ; = thickspace.
<LEN>: length for custom spaces (hspace)

Origin: Andre, 25 Jul 2001; sanda, 16 Jun 2008

LFUN_MATH_MATRIX

Action: Inserts a matrix.

Syntax: math-matrix <COLS> <ROWS> [<ALIGN>]

Params: <ALIGN>: Alignment is a word composed of the vertical alignment (b, c or t) (i.e. 1 char)
and the horizontal alignments (l, c or r) (i.e. <COL> chars).

Sample: math-matrix 3 3 bccc

LFUN_MATH_AMS_MATRIX

Action: Inserts a matrix.

Syntax: math-matrix <COLS> <ROWS> [<DECORATION>]

Params: <DECORATION>: Decoration determines the LATEX name of the matrix that should be
created.

Sample: math-ams-matrix 3 3 bmatrix
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LFUN_MATH_MODE

Action: In text mode enters math mode (i.e. puts math insets on the current cursor position), in
math mode enters text mode inside math expression.

Notion: If there is some selected text, it puts the text inside created math box.

Syntax: math-mode [on|<ARG>]

Params: <ARG>: eventual argument (LATEX code) is passed to LFUN_MATH_INSERT .
"on": allow only entering of math mode from text mode.

Origin: Alejandro, 4 Jun 1996

LFUN_REGEXP_MODE

Action: Enters regexp mode (i.e., puts regexp insets on the current cursor position). Used by the
advanced search dialog.

Notion: If there is any selected text, then it is moved inside the created regexp inset.

Syntax: regexp-mode [<ARG>]

Params: <ARG>: eventual argument (regular expression).

Origin: Tommaso, 4 Oct 2008

LFUN_MATH_NUMBER_LINE_TOGGLE

Action: Toggles numbering of the current formula line.

Notion: Must be in display formula mode.

Syntax: math-number-line-toggle

Origin: Alejandro, 18 Jun 1996

LFUN_MATH_NUMBER_TOGGLE

Action: Toggles numbering/labeling of the current formula.

Notion: Must be in display formula mode.

Syntax: math-number-toggle

Origin: Alejandro, 4 Jun 1996

LFUN_MATH_EXTERN

Action: Calls external program and passes the current expression/equation as an argument for the
calculation in the format appropriate to the given language.

Notion: Selection can be used to determine the input for the external program.

Syntax: math-extern <LANG> [<COMMAND>]

Params: <LANG>: octave|maxima|maple|mathematica|script
where "script" stands fot the external script (normalized expression will be passed)

Sample: math-extern maple simplify

Origin: Andre, 24 Apr 2001

LFUN_MATH_SIZE

Action: Changes arbitrarily the size used by math fonts inside a context.

Notion: Provides an interface to the LATEX math mode font size commands.

Syntax: math-size <STYLE>

Params: <STYLE>: \displaystyle|\textstyle|\scriptstyle|\scriptscriptstyle

Origin: Alejandro, 15 Aug 1996; sanda, 14 Jun 2008
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LFUN_MATH_FONT_STYLE

Action: Changes the text style used in math.

Syntax: math-font-style <STYLE>

Params: <STYLE>: mathnormal|mathcal|mathfrak|mathrm|mathsf|mathbf|textnormal
|textrm|textsf|texttt|textbf|textmd|textit|textsc|textsl|textup

Origin: vfr, 9 jan 2009

LFUN_MATH_MACRO_UNFOLD

Action: Unfold a Math Macro.

Notion: Unfold the Math Macro the cursor is in, i.e. display it as \foo.

Syntax: math-macro-unfold

Origin: sts, 06 January 2008

LFUN_MATH_MACRO_FOLD

Action: Fold a Math Macro.

Notion: Fold the Math Macro the cursor is in if it was unfolded, i.e. displayed as \foo before.

Syntax: math-macro-fold

Origin: sts, 06 January 2008

LFUN_MATH_MACRO_ADD_PARAM

Action: Add a parameter.

Notion: Add a parameter to a Math Macro.

Syntax: math-macro-add-param <NUM>

Params: <NUM>: The number of the parameter behind which the new one will be added (1 for the
�rst, i.e. use 0 for add a parameter at the left), defaults to the last one.

Origin: sts, 06 January 2008

LFUN_MATH_MACRO_REMOVE_PARAM

Action: Remove the last parameter.

Notion: Remove the last parameter of a Math Macro and remove its value in all instances of the
macro in the bu�er.

Syntax: math-macro-remove-param <NUM>

Params: <NUM>: The number of the parameter to be deleted (1 for the �rst), defaults to the last
one.

Origin: sts, 06 January 2008

LFUN_MATH_MACRO_APPEND_GREEDY_PARAM

Action: Append a greedy parameter.

Notion: Append a greedy parameter to a Math Macro which eats the following mathed cell in every
instance of the macro in the bu�er.

Syntax: math-macro-append-greedy-param

Origin: sts, 06 January 2008

LFUN_MATH_MACRO_REMOVE_GREEDY_PARAM

Action: Remove a greedy parameter.

Notion: Remove a greedy parameter of a Math Macro and spit out the values of it in every instance
of the macro in the bu�er. If it is an optional parameter the [valud] format is used.

Syntax: math-macro-remove-greedy-param

Origin: sts, 06 January 2008
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LFUN_MATH_MACRO_MAKE_OPTIONAL

Action: Make a parameter optional.

Notion: Turn the �rst non-optional parameter of a Math Macro into an optional parameter with a
default value.

Syntax: math-macro-make-optional

Origin: sts, 06 January 2008

LFUN_MATH_MACRO_MAKE_NONOPTIONAL

Action: Make a parameter non-optional.

Notion: Turn the last optional parameter of a Math Macro into a non-optional parameter. The default
value is remembered to be reused later if the user changes his mind.

Syntax: math-macro-make-nonoptional

Origin: sts, 06 January 2008

LFUN_MATH_MACRO_ADD_OPTIONAL_PARAM

Action: Add an optional parameter.

Notion: Insert an optional parameter just behind the already existing optional parameters.

Syntax: math-macro-add-optional-param

Origin: sts, 06 January 2008

LFUN_MATH_MACRO_REMOVE_OPTIONAL_PARAM

Action: Remove the last optional parameter.

Notion: Remove the last optional parameter of a Math Macro and remove it in all the instances of
the macro in the bu�er.

Syntax: math-macro-remove-optional-param

Origin: sts, 06 January 2008

LFUN_MATH_MACRO_ADD_GREEDY_OPTIONAL_PARAM

Action: Add a greedy optional parameter.

Notion: Add a greedy optional parameter which eats the value from the following cells in mathed
which are in the [value] format.

Syntax: math-macro-add-greedy-optional-param

Origin: sts, 06 January 2008

LFUN_IN_MATHMACROTEMPLATE

Action: Only active in Math Macro de�nition.

Notion: Dummy function which is only active in a Math Macro de�nition. It's used to toggle the
Math Macro toolbar if the cursor moves into a Math Macro de�nition.

Syntax: in-mathmacrotemplate

Origin: sts, 06 January 2008

LFUN_PARAGRAPH_MOVE_DOWN

Action: Moves the current paragraph downwards in the document.

Syntax: paragraph-move-down

Origin: Edwin, 8 Apr 2006

LFUN_PARAGRAPH_MOVE_UP

Action: Moves the current paragraph upwards in the document.

Syntax: paragraph-move-up

Origin: Edwin, 8 Apr 2006
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LFUN_PARAGRAPH_UP

Action: Move the cursor to the next paragraph (or begining of the current one) in upward direction.

Syntax: paragraph-up

Origin: Asger, 1 Oct 1996

LFUN_PARAGRAPH_UP_SELECT

Action: Move the cursor and select the text to the next paragraph (or begining of the current one)
in upward direction.

Syntax: paragraph-up-select

Origin: Asger, 1 Oct 1996

LFUN_PARAGRAPH_DOWN

Action: Move the cursor to the next paragraph (or begining of the current one) in downward direction.

Syntax: paragraph-down

Origin: Asger, 1 Oct 1996

LFUN_PARAGRAPH_DOWN_SELECT

Action: Move the cursor and select the text to the next paragraph (or begining of the current one)
in downward direction.

Syntax: paragraph-down-select

Origin: Asger, 1 Oct 1996

LFUN_PARAGRAPH_GOTO

Action: Jump to a paragraph given by its id number and optionally the desired position within the
paragraph.

Notion: Note that id number of paragraph is not the sequential number of paragraph seen on the
screen. Moreover the id is unique for all opened bu�ers (documents).

Syntax: paragraph-goto <PAR_ID_NUMBER> <POSITION_IN_PAR>

Params: <PAR_ID_NUMBER>: paragraph id
<POSITION_IN_PAR>: desired position within the paragraph

Origin: Dekel, 26 Aug 2000

LFUN_BREAK_PARAGRAPH

Action: Breaks the current paragraph at the current location.

Notion: Removes the selection.

Syntax: break-paragraph [<LAYOUT>]

Params: <LAYOUT>: "inverse" - decreases depth by one (or change layout to default layout) when
the cursor is at the end of the line.

LFUN_PARAGRAPH_PARAMS

Action: Change paragraph settings.

Notion: Modi�es the current paragraph, or currently selected paragraphs. This function only modi�es,
and does not override, existing settings. Note that the "leftindent" indent setting is deprecated.

Syntax: paragraph-params [<INDENT>] [<SPACING>] [<ALIGN>] [<OTHERS>]

Params: <INDENT>: \noindent|\indent|\indent-toggle|\leftindent LENGTH
<SPACING>: \paragraph_spacing default|single|onehalf|double|other SIZE
<ALIGN>: \align block|left|right|center|default
<OTHERS>: \labelwidthstring WIDTH|\start_of_appendix

Origin: rgh, Aug 15 2007
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LFUN_PARAGRAPH_PARAMS_APPLY

Action: Change paragraph settings.

Notion: Overwrite all nonspeci�ed settings to the default ones. Use paragraph-params lfun if you
don't want to overwrite others settings.

Syntax: paragraph-params-apply <INDENT> <SPACING> <ALIGN> <OTHERS>

Params: For parameters see LFUN_PARAGRAPH_PARAMS

Origin: leeming, 30 Mar 2004

LFUN_PARAGRAPH_UPDATE

Action: Updates the values inside the paragraph dialog from the paragraph.

Notion: This is internal LFUN, not to be used by users. Called internally by LFUN_DIALOG_UPDATE.

Origin: leeming, 13 Mar 2003

LFUN_OUTLINE_UP

Action: Move the current group in the upward direction in the structure of the document.

Notion: The "group" can be Part/Chapter/Section/etc. It moves the whole substructure of the group.

Syntax: outline-up

Origin: Vermeer, 23 Mar 2006

LFUN_OUTLINE_DOWN

Action: Move the current group in the downward direction in the structure of the document.

Notion: The "group" can be Part/Chapter/Section/etc. It moves the whole substructure of the group.

Syntax: outline-down

Origin: Vermeer, 23 Mar 2006

LFUN_OUTLINE_IN

Action: Moves the current group in the downward direction in the hierarchy of the document structure.

Notion: Part -> Chapter -> Section -> etc.

Syntax: outline-in

Origin: Vermeer, 23 Mar 2006

LFUN_OUTLINE_OUT

Action: Moves the current group in the upward direction in the hierarchy of the document structure.

Notion: Part <- Chapter <- Section <- etc.

Syntax: outline-out

Origin: Vermeer, 23 Mar 2006

LFUN_INSET_EDIT

Action: Edit the inset at cursor with an external application, if one is attributed.

Syntax: inset-edit [<INSET_PARAMS>]

Params: <INSET_PARAMS>: Parameters for the inset.
Currently only the �lename will be considered.

Origin: JSpitzm, 27 Apr 2006

LFUN_TABULAR_INSERT

Action: Inserts table into the document.

Notion: See LFUN_INSET_MODIFY for some more details about tabular modi�cations.

Syntax: tabular-insert [<ROWS> <COLUMNS>]

Params: In case no arguments are given show insert dialog.

Origin: Jug, 12 Apr 2000
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LFUN_CELL_BACKWARD

Action: Moves the cursor to the previous cell inside the table.

Syntax: cell-backward

Origin: Jug, 22 May 2000

LFUN_CELL_FORWARD

Action: Moves the cursor to the next cell inside the table.

Syntax: cell-forward

LFUN_CELL_SPLIT

Action: Splits cell and shifts right part to the next cell (inside the math grid).

Syntax: cell-split

Origin: Ale, 15 May 1997

LFUN_VC_REGISTER

Action: Register the document as an �le inside version control system.

Notion: File is registered inside cvs, svn or rcs repository acording to the existence of cvs/svn/rcs
entries in the document's directory.
See LYX Additional Features Manual (Version Control Chapter) for additional information.

Syntax: vc-register

Origin: Lgb, 1 Jul 1997

LFUN_VC_CHECK_IN

Action: Checks-in/commits the changes of the registered �le to the repository.

Notion: In RCS case this also unlocks the �le.

Syntax: vc-check-in

Origin: Lgb, 1 Jul 1997

LFUN_VC_CHECK_OUT

Action: Checks-out the document for edit (and locks it in some cases).

Syntax: vc-check-out

Origin: Lgb, 1 Jul 1997

LFUN_VC_REVERT

Action: Reverts the document to the last check-in/commit in VCS.

Syntax: vc-revert

Origin: Lgb, 1 Jul 1997

LFUN_VC_UNDO_LAST

Action: Undo last check-in.

Notion: This is currently implemented only for RCS.

Syntax: vc-check-out

Origin: Lgb, 1 Jul 1997

26



LFUN_VC_COMMAND

Action: Executes external command. This command is intended to support additional VCS com-
mands.

Syntax: vc-command <FLAG> <PATH> <COMMAND>

Params: <FLAG>: Flags for the command can be combined together.
U - dUmmy - no �ags
D - Doc - need document loaded to proceed
I - dIrty - mark document dirty
R - Reload - ensure that the document is saved and reload it after command execution
M - Message - ask for input string (commit message)
<PATH>: path where to start. $$p will be replaced by the current document path.
<COMMAND>: command to execute. $$i/$$p/$$m will be replaced by the current document(with
absolute path)/path/message.

Sample: vc-command DR $$p "svn up"

Origin: sanda, 13 Jan 2009

LFUN_VC_LOCKING_TOGGLE

Action: Toggles the locking property of the edited �le.

Notion: This is currently implemented only for SVN.

Syntax: vc-locking-toggle

Origin: sanda, 25 Jun 2009

LFUN_VC_REPO_UPDATE

Action: Update the local archive directory in which resides the current document with the remote
repository.

Syntax: vc-repo-update

Origin: sanda, 16 Oct 2009

LFUN_VC_COMPARE

Action: Compares two revisions of the same �le under version control.

Syntax: vc-compare [<REV1>] [<REV2>]

Params: Revision number either points directly to commit in history or if negative number -x it points
to (last commit - x).
In RCS we subtract only in the last number of revision speci�cation. Special case "0" is reserved
for the last committed revision.
<REV1>: Older �le.
<REV2>: Newer �le. Used only if REV1 > 0.
If no parameter is given, interactive dialog will be shown.

Sample: Compare current document against last commit
vc-compare 0
Compare current document against current revision - 5 commits
vc-compare -5
Compare revisions 120 and 155
vc-compare 120 155

Origin: sanda, 12 Feb 2010

LFUN_CHANGES_TRACK

Action: Toggles change tracking to on/o�.

Syntax: changes-track

Origin: levon, 1 Oct 2002
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LFUN_CHANGES_OUTPUT

Action: Toggles showing of change tracking in typesetted output.

Syntax: changes-output

Origin: jspitzm, 21 Jan 2005

LFUN_CHANGE_NEXT

Action: Moves the cursor to the position of the next change of the change tracking records.

Syntax: change-next

Origin: schmitt, 4 Oct 2006

LFUN_CHANGE_PREVIOUS

Action: Moves the cursor to the position of the previous change of the change tracking records.

Syntax: change-previous

Origin: vfr, 4 Apr 2009

LFUN_CHANGES_MERGE

Action: Open change tracking dialog for merging and moves the cursor to the position of the next
change.

Syntax: changes-merge

Origin: Levon, 16 Oct 2002

LFUN_CHANGE_ACCEPT

Action: Accepts tracked change inside the selection.

Syntax: change-accept

Origin: Levon, 16 Oct 2002

LFUN_CHANGE_REJECT

Action: Rejects tracked change inside the selection.

Syntax: change-reject

Origin: Levon, 16 Oct 2002

LFUN_ALL_CHANGES_ACCEPT

Action: Accepts all tracked changes in the document.

Syntax: all-changes-accept

Origin: Levon, 16 Oct 2002

LFUN_ALL_CHANGES_REJECT

Action: Rejects all tracked changes in the document.

Notion: Reject does not work recursively; the user may have to repeat the operation.

Syntax: all-changes-reject

Origin: Levon, 16 Oct 2002

LFUN_INSET_APPLY

Action: Apply data for an inset.

Notion: LFUN_INSET_APPLY is sent from the dialogs when the data should be applied. This is
either changed to LFUN_INSET_MODIFY or LFUN_INSET_INSERT depending on the context
where it is called.

Syntax: inset-apply <ARGS>

Params: See LFUN_INSET_INSERT .
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LFUN_INSET_DISSOLVE

Action: Dissolve the current inset into text.

Syntax: inset-dissolve [<INSET>]

Params: <INSET>: this can be used to make sure the right kind of inset is dissolved. For example
"dissolve" entry in the charstyles sub-menu should only dissolve the charstyle inset, even if the
cursor is inside several nested insets of di�erent type.
For values see lyx::InsetLayout::lyxtype_ .

Origin: JSpitz, 7 Aug 2006

LFUN_INSET_INSERT

Action: Insert new inset (type given by the parameters).

Syntax: inset-insert <INSET> <ARGS>

Params: <INSET>: <bibitem|bibtex|cite|ert|listings|external|graphics|tabular|
hyperlink|include|index|label|line|nomencl|vspace|ref|toc|script>
<ARGS>: depends on the given inset. Use "lyx -dbg action" to explore.

Sample: inset-insert ref LatexCommand <Format> reference "<label name>"\end_inset
where <label name> is the name of the referenced label and <Format> is one of the following:
ref � <reference>
eqref � (<reference>)
pageref � <page>
vpageref � on <page>
vref � <reference> on <page>
formatted � Formatted reference

LFUN_INSET_MODIFY

Action: Modify some properties of an inset.

Notion: Used for bibitem, bibtex, box, branch, command, ert, external, �oats, graphics, include,
index, info, label, listings, newline, newpage, nomencl, note, phantom, ref, space, tabular, vspace,
wrap insets.

Syntax: inset-modify <INSET> <ARGS>inset-modify changetype <TYPE>inset-modify tabular
<FEATURE> [<ARG>]

Params: Generally see LFUN_INSET_INSERT for further details.
In case that <INSET> is "tabular" various math-environment features are handled as well, e.g.
add-vline-left/right for the Grid/Array environment.
<FEATURE>: append-row|append-column|delete-row|delete-column|copy-row|copy-column| toggle-
line-top|toggle-line-bottom|toggle-line-left|toggle-line-right| align-left|align-right|align-center|align-block|align-
decimal|set-decimal-point| valign-top|valign-bottom|valign-middle|longtabular-align-left| longtabular-
align-center|longtabular-align-right|m-align-left|m-align-right| m-align-center|m-valign-top|m-valign-
bottom|m-valign-middle|multicolumn| set-all-lines|unset-all-lines|set-longtabular|unset-longtabular|set-
pwidth| set-mpwidth|set-rotate-tabular|unset-rotate-tabular|toggle-rotate-tabular| set-rotate-cell|unset-
rotate-cell|toggle-rotate-cell|set-usebox|set-lthead| unset-lthead|set-lt�rsthead|unset-lt�rsthead|set-ltfoot|unset-
ltfoot| set-ltlastfoot|unset-ltlastfoot|set-ltnewpage|toggle-ltcaption| set-special-column|set-special-multicolumn|set-
special-multirow| set-booktabs|unset-booktabs|set-top-space|set-bottom-space| set-interline-space|set-
border-lines|tabular-valign-top| tabular-valign-middle|tabular-valign-bottom|set-tabular-width
<ARG>: additional argument for some commands, use debug mode to explore its values.

Sample: inset-modify note Note Comment
inset-modify changetype Ovalbox

LFUN_INSET_DIALOG_UPDATE

Action: Updates the values inside the dialog from the inset.

Notion: This is internal LFUN, not to be used by users. Called internally by LFUN_DIALOG_UPDATE

Params: <DIALOG-NAME>

Origin: leeming, 25 Feb 2003
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LFUN_INSET_SETTINGS

Action: Open the inset's properties dialog.

Notion: Used for bibitem, bibtex, box, branch, citation, ert, external, �oat, graphics, href, include,
index, index_print, label, line, listings, note, phantom, ref, space, tabular, vspace, wrap insets.

Syntax: inset-settings <INSET>

Params: <INSET>: <bibitem|bibtex|box|branch|citation|ert|external|�oat|
graphics|href|include|index|index_print|label|line| listings|note|phantom|ref|space|tabular|vspace|wrap>.

LFUN_INSET_TOGGLE

Action: Toggles the collapsable inset at cursor position, or the inset we are currently in.

Syntax: inset-toggle [<ARG>]

Params: <ARG>: <open|close|toggle|assign>.
open/close/toggle are for collapsable insets. toggle is used when no argument is given.
assign synchronize the branch-inset with activation status of the branch. Used for global toggling
when changed activation.

Origin: lasgouttes, 19 Jul 2001

LFUN_INSET_FORALL

Action: Apply the given commands on insets of a given name.

Notion: WARNING: use at your own risks; this function gives you too many ways of shooting yourself
in the foot. A typical example is inset-forall Note note-insert which starts an in�nite loop. This
is mitigated by the fact that the number of actions is arbitrarily limited to 10000. Note also that
inset-forall does not update metrics between iterations, which can lead to bugs. This has to be
eventually �xed.

Syntax: inset-forall <NAME> <LFUN-COMMAND>
<NAME>: Type of Inset. If <NAME> is *, all insets are matched. The name is used like for
InsetLayout in layout �les: "Note" matches all note insets, while "Note:Note" only matches LYX
yellow note insets.

Sample: Remove all index insets:
inset-forall Index delete-char-forward
Close all Notes (also works for a particular branch, for example):
inset-forall Note inset-toggle close
Transform all yellow notes to comments
inset-forall Note:Note inset-modify note Note Comment
Try to put LYX in an in�nite loop if there is at least a Note:
inset-forall Note char-backward

Origin: lasgouttes, 27 Nov 2009

LFUN_GRAPHICS_RELOAD

Action: Reloads the image if necessary.

Syntax: graphics-reload

Origin: vfr, 10 Aug 2009

LFUN_SET_GRAPHICS_GROUP

Action: Set the group for the graphics inset on the cursor position.

Syntax: set-graphics-group [<GROUP>]

Params: <GROUP>: Id for an existing group. In case the Id is an empty string, the graphics inset
is removed from the current group.

Origin: sanda, 6 May 2008
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LFUN_FINISHED_FORWARD

Action: Moves the cursor out of the current slice, going forward.

Notion: Cursor movement within an inset may be di�erent than cursor movement in the surrounding
text. This action should be called automatically by the cursor movement within the inset, when
movement within the inset has ceased (reached the end of the last paragraph, for example), in order
to move correctly back into the surrounding text.

LFUN_FINISHED_BACKWARD

Action: Moves the cursor out of the current slice, going backwards.

Notion: See also LFUN_FINISHED_FORWARD.

LFUN_FINISHED_RIGHT

Action: Moves the cursor out of the current slice, going right.

Notion: See also LFUN_FINISHED_FORWARD

LFUN_FINISHED_LEFT

Action: Moves the cursor out of the current slice, going left.

Notion: See also LFUN_FINISHED_FORWARD.

LFUN_LANGUAGE

Action: Set language from the current cursor position.

Syntax: language <LANG>

Params: <LANG>: Requested language. Look in lib/languages for the list.

Origin: Dekel, 2 Mar 2000

LFUN_LABEL_GOTO

Action: Goto a label.

Syntax: label-goto [<LABEL>]

Params: <LABEL>: Requested label. If no label is given and reference is on cursor position, Book-
mark 0 is saved and cursor moves to the position of referenced label.

Origin: Ale, 6 Aug 1997

LFUN_LABEL_INSERT

Action: Inserts label to text or displayed formula.

Syntax: label-insert [<LABEL>]

Params: <LABEL>: Requested label. If no label is given dialog requesting name will be opened.

LFUN_REFERENCE_NEXT

Action: Go to the next label or cross-reference.

Syntax: reference-next

Origin: Dekel, 14 Jan 2001

LFUN_BOOKMARK_GOTO

Action: Moves the cursor to the numbered bookmark, opening the �le if necessary. Note that book-
marsk are saved per-session, not per �le.

Notion: Bookmark 0 has a special purpose. It is automatically set
1. to the paragraph you are currently editing
2. to the paragraph from where you are jumping to the last-edited position (jump-back feature)
3. when jumping from crossreference to the requested label by LFUN_LABEL_GOTO.
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Syntax: bookmark-goto <NUMBER>

Params: <NUMBER>: the number of the bookmark to restore.

Origin: Dekel, 27 January 2001

LFUN_BOOKMARK_SAVE

Action: Save a bookmark.

Notion: Saves a numbered bookmark to the sessions �le. The number must be between 1 and 9,
inclusive. Note that bookmarks are saved per-session, not per �le.

Syntax: bookmark-save <NUMBER>

Params: <NUMBER>: the number of the bookmark to save.

Origin: Dekel, 27 January 2001

LFUN_BOOKMARK_CLEAR

Action: Clears the list of saved bookmarks.

Syntax: bookmark-clear

Origin: bpeng, 31 October 2006

LFUN_HELP_OPEN

Action: Open the given help �le according to the language setting.

Syntax: help-open <FILE>[.lyx]

Params: <FILE>: any document from (/usr/share/)doc directory.

Origin: Jug, 27 Jun 1999

LFUN_LYX_QUIT

Action: Terminates the current LYX instance.

Notion: Terminates the current LYX instance, asking whether to save modi�ed documents, etc.

Syntax: lyx-quit

LFUN_TOOLBAR_TOGGLE

Action: Toggles visibility of a given toolbar between on/o�/auto.

Notion: Skipping "auto" when allowauto is false.

Syntax: toolbar-toggle <NAME> [allowauto]

Params: <NAME>: standard|extra|table|math|mathmacrotemplate|
minibu�er|review|view/update|math_panels|vcs| view-others|update-others

Origin: Edwin, 21 May 2007

LFUN_MENU_OPEN

Action: Opens the menu given by its name.

Syntax: menu-open <NAME>

Params: <NAME>: menu name. See various .inc �les in lib/ui for candidates.

LFUN_UI_TOGGLE

Action: Various UI visibility-toggling actions.

Syntax: ui-toggle <statusbar|menubar|scrollbar|frame|fullscreen>

Params: statusbar : Toggle visibility of the statusbar.
menubar : Toggle visibility of the menubar.
scrollbar : Toggle visibility of the scrollbar.
frame : Toggle visibility of the frames around editing window.
fullscreen : Toggle fullscreen mode. This also covers calling the previous functions. However
LFUN_TOOLBAR_TOGGLE for the custom tweaks of the toolbars should be used.

Origin: sanda, 9 Feb 2007
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LFUN_WINDOW_NEW

Action: Creates new empty LYX window.

Notion: Already opened documents from the previous window can be found under View menu.

Syntax: window-new [<GEOMETRY>]

Params: <GEOMETRY>: pass the geometry of the window. This parameter is currently accepted
only on Windows platform.

Origin: Abdel, 21 Oct 2006

LFUN_WINDOW_CLOSE

Action: Closes the current LYX window.

Syntax: window-close

Origin: Abdel, 23 Oct 2006

LFUN_SPLIT_VIEW

Action: Creates another split view of current bu�er.

Notion: All split views act in the same way indpendently.

Syntax: split-view <vertical|horizontal>

Params: horizontal : The work areas are laid out side by side.
vertical : The work areas laid out vertically.

Origin: Abdel, 20 Feb 2008

LFUN_CLOSE_TAB_GROUP

Action: Close the current tab group.

Notion: This only closes the work areas, not the bu�er themselves. The still opened bu�ers can be
visualized in another tab group.

Syntax: close-tab-group

Origin: Abdel, 21 Feb 2008

LFUN_DIALOG_SHOW

Action: Shows hidden dialog or create new one for a given function/inset settings etc.

Syntax: dialog-show <NAME> [<DATA>]

Params: <NAME>: aboutlyx|bibitem|bibtex|box|branch|changes|character|citation|
compare|document|errorlist|ert|external|�le|�ndreplace|�ndreplaceadv|�oat|
graphics|href|include|index|index_print|info|label|line|listings|log|mathdelimiter|
mathmatrix|mathspace|nomenclature|nomencl_print|note|paragraph|phantom|prefs|
print|ref|sendto|space|spellchecker|symbols|tabular|tabularcreate|
thesaurus|texinfo|toc|view-source|vspace|wrap|<SPECIAL>
<SPECIAL>: latexlog|vclog
<DATA>: data, usually settings for the given dialog. Use debug mode for the details.

Origin: leeming, 17 Jun 2003

LFUN_DIALOG_SHOW_NEW_INSET

Action: Shows hidden dialog or create new one for a given inset settings etc.

Notion: Internally uses LFUN_DIALOG_SHOW with processed data for a given inset.

Syntax: dialog-show-new-inset <NAME> [<DATA>]

Params: See LFUN_DIALOG_SHOW .

Origin: leeming, 25 Feb 2003
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LFUN_DIALOG_UPDATE

Action: Updates the dialog values from the inset/paragraph/document.

Syntax: dialog-update <NAME>

Params: <NAME>: paragraph|prefs|<INSET>
<INSET>: inset name

Origin: leeming, 25 Feb 2003

LFUN_DIALOG_HIDE

Action: Hides showed dialog. Counterpart to LFUN_DIALOG_SHOW .

Syntax: dialog-hide <NAME>

Params: See LFUN_DIALOG_SHOW .

Origin: leeming, 25 Feb 2003

LFUN_DIALOG_TOGGLE

Action: Toggles dialog between showed/hidden state.

Notion: Internally uses LFUN_DIALOG_SHOW , LFUN_DIALOG_HIDE .

Syntax: dialog-toggle <NAME> [<DATA>]

Params: See LFUN_DIALOG_SHOW .

Origin: JSpitzm, 30 Apr 2007

LFUN_DIALOG_DISCONNECT_INSET

Action: Closes opened connection to opened inset.

Notion: Connection is used for apply functions.

Syntax: dialog-disconnect-inset <INSET-NAME>

Origin: leeming, 25 Feb 2003

LFUN_MOUSE_PRESS

Action: This function is called when mouse button is pressed (inside workarea). Action depends on
the context.

Notion: This is internal LFUN, not to be used by users.

Origin: Andre, 9 Aug 2002

LFUN_MOUSE_DOUBLE

Action: This function is called when double click on mouse button is pressed (inside workarea). Action
depends on the context.

Notion: This is internal LFUN, not to be used by users.

Origin: Andre, 9 Aug 2002

LFUN_MOUSE_TRIPLE

Action: This function is called when triple click on mouse button is pressed (inside workarea). Action
depends on the context.

Notion: This is internal LFUN, not to be used by users.

Origin: Andre, 9 Aug 2002

LFUN_MOUSE_MOTION

Action: This function is called when mouse cursor is moving over the text. Action depends on the
context.

Notion: This is internal LFUN, not to be used by users.

Origin: Andre, 9 Aug 2002
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LFUN_MOUSE_RELEASE

Action: This function is called when mouse button is released (inside workarea). Action depends on
the context.

Notion: This is internal LFUN, not to be used by users.

Origin: Andre, 9 Aug 2002

LFUN_KEYMAP_OFF

Action: Turn o� the loaded keyboard map.

Syntax: keymap-o�

LFUN_KEYMAP_PRIMARY

Action: Turn on the primary keyboard map.

Notion: Maps were widely used in past, when X-windows didn't have nowadays keyboard support.
They can be still used to maintain uniform keyboard layout across the various plaforms.
The language is to be set in the Preferences dialog.

Syntax: keymap-primary

LFUN_KEYMAP_SECONDARY

Action: Turn on the secondary keyboard map.

Syntax: keymap-secondary

LFUN_KEYMAP_TOGGLE

Action: Toggles keyboard maps (�rst/second/o�).

Syntax: keymap-toggle

Origin: leeming, 30 Mar 2004

LFUN_SERVER_GET_LAYOUT

Action: Returns the current layout (that is environment) name on the cursor position.

Syntax: server-get-layout

LFUN_SERVER_GET_FILENAME

Action: Returns path and �le name of the currently edited document.

Syntax: server-get-�lename

LFUN_SERVER_GOTO_FILE_ROW

Action: Sets the cursor position in LYX based on the row number of generated TEX �le.

Notion: This can be useful for DVI inverse-search or detection of the problematic line from LATEX
compilation. Note that before this function can be used export to LATEX output must occur (in
order to map the row numbers).

Syntax: server-goto-�le-row <FILE[.ext]> <ROW_NUMBER>

Params: <FILE>: the path and �lename. Environment variables are expanded in the path. In case
this LFUN does not work make sure you are giving correct path to the �le.
If the �le is located inside LYX temporary directory it will be mapped back into the appropriate
opened bu�er (e.g. for the case of generated .tex �le).
.ext: extensions will be automatically replaced by .lyx.
<ROW_NUMBER> The row number of the LATEX �le to which to go.

Sample: server-goto-�le-row /home/user/example.lyx 41
server-goto-�le-row /tmp/lyx_tmpdir.XM3088/lyx_tmpbuf0/example.tex 41

Origin: Edmar, 23 Dec 1998
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LFUN_FORWARD_SEARCH

Action: Sets the cursor position in the previewed (dvi/pdf) �le based on the row number in LYX
window.

Notion: The external program used for forward search call can be speci�ed in LYX Output preferences.
See Additional manual for details of these settings.

Syntax: forward-search

Origin: sanda, 14 Apr 2010

LFUN_SERVER_NOTIFY

Action: Sends notify message about the last key-sequence to client.

Notion: This can be used to grab last key-sequence used inside the LYX window. See also Debug
extensions section in Additional features manual.

Syntax: server-notify

LFUN_SERVER_SET_XY

Action: Sets the cursor position based on the editing area coordinates (similar as clicking on that
point with left mouse button).

Syntax: server-set-xy <X> <Y>

LFUN_SERVER_GET_XY

Action: Returns the coordinates of cursor position in the editing area.

Syntax: server-get-xy

LFUN_BUILD_PROGRAM

Action: Generates the code (literate programming).

Notion: Latex �le with extension \literate_extension is generated. Then LYX invokes \build_command
(with a default of�make�) to generate the code and \build_error_�lter to process the compilation
error messages.
In case you want to process your literate �le with a script, or some other program, just insert in
your lyxrc �le an entry with:
\build_command "my_script my_arguments"
The \build_error_�lter di�ers from the \literate_error_�lter only in that the former will identify
error messages from your compiler.

Syntax: build-program

LFUN_BUFFER_AUTO_SAVE

Action: Saves the current bu�er to a temporary �le.

Notion: Saves the current bu�er to a �le named "#�lename#". This LFUN is called automatically
by LYX, to "autosave" the current bu�er.

Syntax: bu�er-auto-save

LFUN_BUFFER_CHILD_OPEN

Action: Loads the given child document.

Notion: The current document is treated as a parent.

Syntax: bu�er-child-open <FILE>

Params: <FILE>: Filename of the child. The directory of the parent is assumed by default.

Origin: Ale, 28 May 1997
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LFUN_BUFFER_CHKTEX

Action: Runs chktex for the current document.

Syntax: bu�er-chktex

Origin: Asger, 30 Oct 1997

LFUN_BUFFER_TOGGLE_COMPRESSION

Action: Toggles compression of the current document on/o�.

Syntax: bu�er-toggle-compression

Origin: bpeng, 27 Apr 2006

LFUN_BUFFER_TOGGLE_OUTPUT_SYNC

Action: Toggles including of resources for forward/reverse search of the given document.

Notion: When toggled on, SyncTEX is invoked for PDF, while srcltx package is used for DVI. Custom
LATEX macro can be de�ned in preferences.

Syntax: bu�er-toggle-output-sync

Origin: sanda, 25 May 2010

LFUN_BUFFER_CLOSE

Action: Closes the current bu�er.

Notion: Closes the current bu�er, asking whether to save it, etc, if the bu�er has been modi�ed.

Syntax: bu�er-close

LFUN_BUFFER_CLOSE_ALL

Action: Closes all bu�ers.

Notion: Closes all bu�ers, asking whether to save it, etc, if a bu�er has been modi�ed.

Syntax: bu�er-close-all

LFUN_BUFFER_EXPORT

Action: Exports the current bu�er (document) to the given format.

Syntax: bu�er-export <FORMAT>

Params: <FORMAT> is either "custom" or one of the formats which you can �nd in Tools->Preferences-
>File formats->Format. Usual format you will enter is "pdf2" (pd�atex), "pd�atex" (plain tex for
pd�atex) or "ps" for postscript.
In case of "custom" you will be asked for a format you want to start from and for the command that
you want to apply to this format. Internally the control is then passed to LFUN_BUFFER_EXPORT_CUSTOM.

Origin: Lgb, 29 Jul 1997

LFUN_BUFFER_EXPORT_CUSTOM

Action: Exports the current bu�er (document) from the given format using the given command on
it.

Syntax: bu�er-export-custom <FORMAT> <COMMAND>

Params: <FORMAT> format to start from (LYX will care to produce such intermediate �le).
<COMMAND> this command will be launched on the �le. Note that you can use "$$FName"
string to qualify the intermediate �le.

Sample: bu�er-export-custom dvi dvips -f $$FName -o my�le.ps

Origin: leeming, 27 Mar 2004
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LFUN_BUFFER_PRINT

Action: Prints the current document.

Notion: Many settings can be given via the preferences dialog.

Syntax: bu�er-print <TARGET> <TARGET-NAME> <COMMAND>

Params: <TARGET> is either "printer" or "�le".
<TARGER-NAME> is either "default" or �le name or printer name.
<COMMAND> command ensuring the printing job.

Sample: bu�er-print �le "/trash/new�le1.ps" "dvips"

Origin: leeming, 28 Mar 2004

LFUN_BUFFER_IMPORT

Action: Import a given �le as a lyx document.

Notion: File can be imported i� lyx �le format is (transitively) reachable via de�ned convertors in
preferences. Look into File->Import menu to get an idea of the currently active import formats.

Syntax: bu�er-import <FORMAT> [<FILE>]

Origin: Asger, 24 Jul 1998

LFUN_BUFFER_NEW

Action: Creates a new bu�er (that is, document).

Notion: Implicit path can be set in Preferences dialog.

Syntax: bu�er-new [<FILE>]

Params: <FILE>: �lename of created �le with absolute path.

LFUN_BUFFER_NEW_TEMPLATE

Action: Creates a new bu�er (that is, document) from a template.

Notion: Path for new �les and templates can be set in Preferences dialog. Template will be asked for
via Open-dialog.

Syntax: bu�er-new-template [<FILE>]

Params: <FILE>: �lename of created �le with absolute path.

LFUN_BUFFER_RELOAD

Action: Reverts opened document.

Syntax: bu�er-reload

Origin: Asger, 2 Feb 1997

LFUN_BUFFER_SWITCH

Action: Display/switch to the given bu�er.

Syntax: bu�er-switch <BUFFER>

Params: <BUFFER>: path and �lename of already opened (but possibly hidden) document which
is to be shown.

LFUN_BUFFER_TOGGLE_READ_ONLY

Action: Toggle editing mode of the current document between read/write and read-only.

Notion: This function is not allowed if the �le is under version control, since read-only �ag is often
used in version control �le locking.

Syntax: bu�er-toggle-read-only

Origin: Lgb, 27 May 1997
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LFUN_BUFFER_VIEW

Action: Displays current bu�er in chosen format.

Notion: Displays the contents of the current bu�er in the chosen format, for example, PDF or DVI.
This runs the necessary converter, calls the de�ned viewer, and so forth.

Syntax: bu�er-view [<FORMAT>]

Params: <FORMAT>: The format to display, where this is one of the formats de�ned (in the current
GUI) in the Tools>Preferences>File Formats dialog. If no format is given, the default format as
speci�ed in the same dialog is used.

LFUN_BUFFER_UPDATE

Action: Exports the current document and put the result into the temporary directory.

Notion: In case you are already viewing the exported document (see LFUN_BUFFER_VIEW) the
output will be rewriten - updated. This is useful in case your viewer is able to detect such changes
(e.g. ghostview for postscript).

Syntax: bu�er-update [<FORMAT>]

Params: <FORMAT>: The format to display, where this is one of the formats de�ned (in the current
GUI) in the Tools>Preferences>File Formats dialog. If no format is given, the default format as
speci�ed in the same dialog is used.

Origin: Dekel, 5 Aug 2000

LFUN_BUFFER_WRITE

Action: Saves the current bu�er.

Notion: Saves the current bu�er to disk, using the �lename that is already associated with the bu�er,
asking for one if none is yet assigned.

Syntax: bu�er-write

LFUN_BUFFER_WRITE_AS

Action: Rename and save current bu�er.

Syntax: bu�er-write-as <FILENAME>

Params: <FILENAME>: New name of the bu�er/�le. A relative path is with respect to the original
location of the bu�er/�le.

LFUN_BUFFER_WRITE_ALL

Action: Save all changed documents.

Syntax: bu�er-write-all

Origin: rgh, gpothier 6 Aug 2007

LFUN_BUFFER_NEXT

Action: Switch to the next opened document.

Notion: Note that this does not necessarily mean next in tabbar (for full list see View menu).

Syntax: bu�er-next

LFUN_BUFFER_PREVIOUS

Action: Switch to the previous opened document.

Syntax: bu�er-previous
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LFUN_MASTER_BUFFER_UPDATE

Action: When run from a child document, this updates (exports) document built from the master
bu�er, if available.

Syntax: master-bu�er-update [<FORMAT>]

Params: <FORMAT>: The format to display, where this is one of the formats de�ned (in the current
GUI) in the Tools>Preferences>File Formats dialog. If no format is given, the default format as
speci�ed in the same dialog is used.

Origin: Tommaso, 20 Sep 2007

LFUN_MASTER_BUFFER_VIEW

Action: When run from a child document, this command shows a preview built from the master
bu�er, if available.

Syntax: master-bu�er-view [<FORMAT>]

Params: <FORMAT>: The format to display, where this is one of the formats de�ned (in the current
GUI) in the Tools>Preferences>File Formats dialog. If no format is given, the default format as
speci�ed in the same dialog is used.

Origin: Tommaso, 20 Sep 2007

LFUN_BUFFER_LANGUAGE

Action: Set language of the current document.

Syntax: bu�er-language <LANG>

Params: <LANG>: language name. See lib/languages for list.

Origin: leeming, 30 Mar 2004

LFUN_BUFFER_SAVE_AS_DEFAULT

Action: Save the current document settings as default.

Notion: The �le will will be saved into ~/.lyx/templates/defaults.lyx .

Syntax: bu�er-save-as-default [<ARGS>]

Params: <ARGS>: contains the particular settings to be saved. They obey the syntax you can �nd
in document header of usual .lyx �le.

Origin: leeming, 30 Mar 2004

LFUN_BUFFER_PARAMS_APPLY

Action: Apply the given settings to the current document.

Syntax: bu�er-params-apply [<ARGS>]

Params: <ARGS>: contains the particular settings to be saved. They obey the syntax you can �nd
in document header of usual .lyx �le.

Origin: leeming, 30 Mar 2004

LFUN_FILE_INSERT

Action: Inserts another LYX �le.

Syntax: �le-insert [<FILE>]

Params: <FILE>: Filename to be inserted.

LFUN_FILE_INSERT_PLAINTEXT

Action: Inserts plain text �le.

Syntax: �le-insert-plaintext [<FILE>]

Params: <FILE>: Filename to be inserted.

Origin: CFO-G, 19 Nov 1997
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LFUN_FILE_INSERT_PLAINTEXT_PARA

Action: Inserts plain text �le as paragraph (i.e. join lines).

Syntax: �le-insert-plaintext-para [<FILE>]

Params: <FILE>: Filename to be inserted.

Origin: Levon, 14 Feb 2001

LFUN_FILE_OPEN

Action: Open LYX document.

Syntax: �le-open [<FILE>]

Params: <FILE>: Filename to be opened.

LFUN_CALL

Action: Executes a command de�ned in a .def �le.

Notion: The de�nitions are by default read from lib/commands/default.def.
A .def �le allows to de�ne a command with \de�ne "<NAME>" "<LFUN>" where <NAME> is the
name of the new command and <LFUN> is the lfun code to be executed (see e.g. LFUN_COMMAND_SEQUENCE).
\def_�le "FileName" allows to include another .def �le.
This is particularly useful in connection with toolbar buttons: Since the name of the button image
for this lfun is lib/images/commands/<NAME>.png this is the way to assign an image to a complex
command-sequence.

Syntax: call <NAME>

Params: <NAME>: Name of the command that must be called.

Origin: broider, 2 Oct 2007

LFUN_META_PREFIX

Action: Simulate halting Meta key (Alt key on PCs).

Notion: Used for bu�er editation not for GUI control.

Syntax: meta-pre�x

LFUN_CANCEL

Action: Cancels sequence prepared by LFUN_META_PREFIX .

Syntax: cancel

LFUN_COMMAND_EXECUTE

Action: Switches the focus to the minibu�er so that the user can type in there. If necessary, it opens
the minibu�er toolbar.

Notion: Usually bound to M-x shortcut.

Syntax: command-execute

LFUN_COMMAND_PREFIX

Action: Return the current key sequence and available options as a string.

Notion: No options are added if no current map exists.
This is probably usable only with connection to lyxserver.

Syntax: command-pre�x

LFUN_COMMAND_SEQUENCE

Action: Run more commands (LFUN and its parameters) in a sequence.

Syntax: command-sequence <CMDS>

Params: <CMDS>: Sequence of commands separated by semicolons.

Sample: command-sequence cut; ert-insert; self-insert \; paste; self-insert {}; inset-toggle;

Origin: Andre, 11 Nov 1999
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LFUN_COMMAND_ALTERNATIVES

Action: Runs the �rst listed command that is enabled.

Notion: This can be used to bind multiple functions to a single key, and then which one is used will
depend upon the context.

Syntax: command-alternatives <CMDS>

Params: <CMDS>: Sequence of commands separated by semicolons.

Sample: command-alternatives completion-accept;cell-forward

Origin: rgh, 24 September 2008

LFUN_MESSAGE

Action: Shows message in statusbar (for script purposes).

Syntax: message <STRING>

Origin: Lgb, 8 Apr 2001

LFUN_DEBUG_LEVEL_SET

Action: Set debug output level.

Syntax: debug-level-set <LEVEL>

Params: <LEVEL>: comma separated list of levels or the correspondent number of their combina-
tion. 0 is equivalent to disabling all debug events. See lyx -dbg for the current list of debug levels
and their numbers.

Origin: sanda, 28 Dec 2009

LFUN_PREFERENCES_SAVE

Action: Save user preferences.

Syntax: preferences-save

Origin: Lgb, 27 Nov 1999

LFUN_RECONFIGURE

Action: Recon�gure the automatic settings.

Syntax: recon�gure

Origin: Asger, 14 Feb 1997

LFUN_LYXRC_APPLY

Action: Apply the given settings to user preferences.

Syntax: lyxrc-apply <SETTINGS>

Params: <SETTINGS>: settings which are to be set. Take a look into ~/.lyx/preferences to get
an idea which commands to use and their syntax. lyx::LYXRC::LYXRCTags has the list of possible
commands.

LFUN_CURSOR_FOLLOWS_SCROLLBAR_TOGGLE

Action: Determine whether keep cursor inside the editing window regardless the scrollbar movement.

Syntax: toggle-cursor-follows-scrollbar

Origin: ARRae, 2 Dec 1997

LFUN_SET_COLOR

Action: Set the given LYX color to the color de�ned by the X11 name given.

Notion: A new color entry is created if the color is unknown. Color names can be stored as a part of
user settings.

Syntax: set-color <LYX_NAME> <X11_NAME>

Origin: SLior, 11 Jun 2000
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LFUN_STATISTICS

Action: Count the statistics (number of words and characters) in the document or in the given selec-
tion.

Notion: Note that this function gives the number of words/chars written, not the number of characters
which will be typeset.

Syntax: statistics

Origin: lasgouttes, Jan 27 2004; sanda, Jan 8 2008

LFUN_COMPLETION_INLINE

Action: Show the inline completion at the cursor position.

Syntax: completion-inline

Origin: sts, Feb 19 2008

LFUN_COMPLETION_POPUP

Action: Show the completion popup at the cursor position.

Syntax: completion-popup

Origin: sts, Feb 19 2008

LFUN_COMPLETION_COMPLETE

Action: Try to complete the word or command at the cursor position.

Syntax: complete

Origin: sts, Feb 19 2008

LFUN_COMPLETION_CANCEL

Action: Try to cancel completion, either the popup or the inline completion.

Syntax: completion-cancel

Origin: sts, Sep 07 2008

LFUN_COMPLETION_ACCEPT

Action: Accept suggested completion.

Syntax: completion-accept

Origin: sanda, Sep 08 2008

LFUN_BRANCH_ADD

Action: Add a branch to the bu�er's BranchList.

Syntax: branch-add <BRANCH>

Params: <BRANCH>: Name of the branch to add

Origin: spitz, 7 Jul 2009

LFUN_BRANCH_ACTIVATE

Action: Activate the branch.

Syntax: branch-activate <BRANCH>

Params: <BRANCH>: The branch to activate

Sample: lyx -x "branch-activate answers" -e pdf2 �nalexam.lyx
could be used to export a pdf with the answers branch included without one's having to open LYX
and activate the branch manually.

Origin: rgh, 27 May 2008
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LFUN_BRANCH_DEACTIVATE

Action: De-activate the branch.

Syntax: branch-deactivate <BRANCH>

Params: <BRANCH>: The branch to deactivate

Origin: rgh, 27 May 2008

LFUN_BRANCHES_RENAME

Action: Rename all branches of a given name in a document.

Syntax: branches-rename <OLDNAME> <NEWNAME>

Params: <OLDNAME>: Current name of the branch to be renamed <NEWNAME>: New name of
the branch

Origin: spitz, 9 Jul 2009

LFUN_BRANCH_ADD_INSERT

Action: Create new branch and directly put the branch inset into the document.

Syntax: branch-add-insert [<NAME>]

Params: <NAME>: Branch name. If it is not speci�ed, you will be asked.

Origin: sanda, 10 Jul 2009

LFUN_LABEL_COPY_AS_REF

Action: Copies the label at the cursor as a cross-reference to be pasted elsewhere.

Syntax: copy-label-as-reference <LABEL>

Params: <LABEL>: The label to copy (for multi-line math)

Origin: sts, 16 Nov 2008

LFUN_LABEL_INSERT_AS_REF

Action: Inserts the label as a cross-reference at the position of the cursor.

Syntax: label-insert-as-reference

Origin: vfr, 7 Apr 2009

LFUN_BUFFER_ZOOM_IN

Action: Increases the zoom of the screen fonts.

Syntax: bu�er-zoom-in [<ZOOM>]

Params: <ZOOM>: The zoom in %, the default is 20.

Origin: vfr, 30 Mar 2009

LFUN_BUFFER_ZOOM_OUT

Action: Decreases the zoom of the screen fonts.

Syntax: bu�er-zoom-out [<ZOOM>]

Params: <ZOOM>: The zoom in %, the default is 20.

Origin: vfr, 30 Mar 2009

LFUN_INSET_COPY_AS

Action: Copies the inset to the clipboard as a certain type.

Notion: Currently used only for InsetInfo where its content is copied as a text.

Syntax: inset-copy-as

Origin: vfr, 18 Apr 2010
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